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3 reasons to like dynamic input 

As you know, dynamic input provides a command interface near the cursor to help you keep your focus in 

the drafting area. When dynamic input is on, tooltips display information near the cursor that is dynamically 

updated as the cursor moves. When a command is active, the tooltips provide a place for user entry and 

there are command options which are more intuitive and convenience to select. Here there are 3 reasons to 

like dynamic input: 

1. Get command faster:  

With dynamic input you will save time typing and finding out whatever longer or shorter command name 

rather than using the command line or selecting a command at toolbars! Whatõs more, dynamic input can 

auto complete the command name at once. When type a command using the dynamic input, it displays a 

list of all the commands whose prefix matches what you've typed plus it will displays all their icons making 

easier to recognize them at glance. 

 

 

 

 

 

2. Flexible methods to select a command option 

1st. Method: After entering a command just type the CAPITAL letter of the option to be selected 

and press ENTER. Then the tooltip will prompt the command message. 

 

2nd. Method: After entering a command 

just use the arrow keys (right/left) to 

cycle select the option and press 

ENTER. Notice while selecting any 

option, this will be dot highlighted.  

Interface 
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Under the same method, after pressing 

the right arrow key, users can select an 

option using the cursor as they like. 

Notice when hovering the cursor over 

an option, it will be color highlighted 

 

3. Customized dynamic input options 

 

Within Drafting Settings dialog box, 

under Dynamic Input tab, there is an 

option called Show Dynamic Input 

Tooltip near the crosshairs. By default, 

this option is checked, but if you 

uncheck it, when executing a 

command, the dynamic input tooltip 

will be fixed and away from the 

crosshair. 

 

When the dynamic input tooltip is fixed, it turns semi-transparent as default. At this stage you 

can freely move the cursor over the workspace but when you move it over the dynamic input, it 

will be highlighted. Whatõs more, you can select a command option with the cursor.  

If you already select the option Show Dynamic 

Input Tooltip near the crosshairs, you can drag 

with the cursor, the dynamic input tooltip to 

anywhere around workspace. When dynamic 

input is dragged, it turns highlight. 

 

 

Within Drafting Settings dialog box, under Dynamic Input tab, there is an option called 

Automatically Enter when the keyword is Matched.  This option allows to typing the CAPITAL 

letter of the command option to be selected. After typed, you donõt need to press ENTER. The 

option will be executed automatically. With this option ,your drafting design efficiency can be 

enhanced greatly. 
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How to cycle commands? 

As a new or experience CAD user, you might found that GstarCAD has a lot of commands. Not to mention 

changing the system variables. Some (well, manyê) of them have to be activated from command line. 

It is very difficult to remember all of them. Even for experienced users. Donõt worry, you can just type first 

one or two characters, and cycle between those commands! 

For example, type two characters like ôreõ to find out what commands started with them. Then press down 

arrow, keep pressing for several times. You will see the commands cycling in dynamic input. 

 

 

 

How to perform transparent commands? 

You can use many commands transparently like pan, zoom, setvar, about, help, OSNAP, CAL, color, etc. You 

can enter them on the command line while another command is active. To use a command transparently, 

enter an apostrophe (') before entering the command. After you complete the transparent command, the 

original command resumes. Example: 

 

Command: L  

LINE Specify first point: 'p  

>>Press ESC or ENTER to exit, or right - click to display shortcut menu.  

Resuming LINE command.  

Specify first point:   

 

 

 

http://www.cadforum.cz/cadforum_en/command.asp
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How to change zoom speed? 

Have you ever felt like the middle mouse wheel zoom is too fast or too slow when drawing? It can depend 

on the scale of the drawing and objects you are working on, or perhaps even your mood. This speed of the 

zoom in and out is controlled by a system variable named ZOOMFACTOR. The default of the system 

variable ZOOMFACTOR is 60. You type ZOOMFACTOR and then change the value.  

This is another one of those little settings that allow you to make GstarCAD more tailored to your use 

whether you like warp speed zooms or turtle slow zooming with the mouse wheel.  

 

How to change zoom direction? 

Another related system variable is ZOOMWHEEL which can toggles the direction of transparent zoom 

operations when you scroll the middle mouse wheel. 

0 Moves wheel forward zooms in; moving wheel backwards zooms out. 

 

 

 

 

 

 

 

1 Move wheel forward zooms out; moving wheel backwards zooms in. 

 

 

 

 

 

 

 

http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/index.html?url=WS1a9193826455f5ff-5187222b11eeadcdc61-56ff.htm,topicNumber=d0e188116
http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/files/WSfacf1429558a55de1a7524c1004e616f8b-64f4.htm
http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/files/WSfacf1429558a55de1a7524c1004e616f8b-64f4.htm
http://www.autodesk.com/autocad
http://docs.autodesk.com/ACD/2010/ENU/AutoCAD%202010%20User%20Documentation/files/WS1a9193826455f5ffa23ce210c4a30acaf-4db2.htm
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How do I pack my files with eTransmit? 

Do you often need to send your drawing files to your customers? But quite often they have troubles to see 

all drawing resource attached like reference paths broken, or donõt include the plot style table, custom fonts, 

etc. There is a tool that can be very useful for these situations: eTransmit will pack your related files into a 

transmittal package. Includes your reference files, plot style table, reorganize your reference path, material 

textures, data link files, etc. You can open eTransmit by accessing GstarCAD menu: File>eTransmit. 

 

 

 

 

 

 

 

                                                                                                                                                              

 

Click Transmittal setup and click modify. Youõll see a lot of option that you can use. You can change path 

option, so all your files will be included in one folder. So you donõt have to worry your path will be broken. 

 

 

 

 

 

 

 

 

Share & File options 

http://cad-notes.com/2010/10/quick-and-dirty-tip-resolving-autocad-xref-path/
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Or you can simply bind it all to a master file. Some cad users are not familiar with external reference, so 

sometimes bind them all in master file can be a good idea. You can also choose what types of file to be 

included. Sometimes you donõt want your partner to have excel file in data links. Or maybe they already 

share same fonts or material textures. If you will send this file to your partner using old version of GstarCAD, 

you can choose to convert it all first. 

 

 

 

 

 

 

 

 

 

 

How to set a previous file version as default? 

Do you have to work with different drawing versions? Or maybe you mostly have to send your DWG files in 

older file format? You can set to save the files to older file format version, by default. 

You can access it in option dialog box, in open and save tab, under File Save option. Also, in the Save 

drawing as dialog box, select options and change the default to the lowest file format the other users can 

open it. Now you donõt have to worry the others canõt open your GstarCAD files! 
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3 ways to modify block definition  

Block is very useful as reusable contents. And when you need to 

create similar objects in your drawing. One of the most popular 

benefits is when you need to modify all instances; you only need to 

modify one. All other instance will be automatically updated. We will 

see 3 methods that you can use to modify your block definition. 

 

1. Explode and recreate the block: 

Long time ago, the only way to edit a block was by exploding it to simpler objects through EXPLODE 

command. Made any changes necessary, then recreate a block with the same name. This method has 

become obsolete but reliable if you are still using old CAD versions. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Edit block in-place:  

Edit block in-place is a great way to modify block when you want to use other objects in the drawing as 

reference. The tool we use is actually REFEDIT. It was originally for reference editing, but works for blocks too. 

Block 
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You can activate this by selecting a block, right click then choose edit block in-place from context menu. Or 

by using REFEDIT command. 

 

 

 

 

 

 

 

 

 

This tool is not block editor. So donõt expect you will see specific block editing tools like in block editor. You 

can add or remove objects to your block. 

3. Using block editor:  

Block editor is a very powerful tool to edit your block. Not only allow you to modify your block geometry, 

you can also create a dynamic block here. You can activate block editor in different ways by double clicking 

a block OR select a block then right click mouse> choose block editor from context menu. You can also 

choose from GstarCAD ribbon> Insert tab>Block definition panel>Block editor OR go to tools tab at menu 

bar and choose> block editor. 

 

 

 

 

 

 

 

 

 

One thing you must remember. When working with block editor, 0,0 is the insertion point. So donõt move 

the geometry unless you want to move the insertion point! 
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How to duplicate block definition? 

When we want to create a similar block from existing block, how do you do it? Explode it and recreate block 

with different name? You will have a lot of problem when you have block with many dynamic block 

parameters and actions! In dynamic block editor, we can save the block as different name. Yes, there is ôsave 

block asõ tool in open/save panel! 
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How to add descriptions to blocks? 

GstarCAD has the ability to add descriptions to the block definitions in the drawing. 

1. Issue the BLOCK command. 

2. Select the block from the list at top. 

3. Click in the lower 'Description' section and enter the description. 

4. Choose OK to redefine the block with the new description. 

 

 

 

 

                                                                                                                                    

How do I control the prompt order for attributes? 

When building the block definition, the selection order is the key.  If you simply window off the geometry 

there is a good possibility the prompt order will not be as desired.   

 

 

                                                                                                                                                                                                

When selecting objects for a block definition, first individually pick the attribute definitions individually in the 

order you want to be prompted, then select the rest of the geometry. 
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How to maintain the attributes value when exploding? 

Block attributes is a nice tool to have. We can use it to preserve text style and size as annotation block. 

Drawing title and title block is a good example. The problem is when we need it explode it somehow, we will 

lose any information we put in the attribute. To preserve the values, do not use explode command, use 

BURST instead. 

 

  

 

 

 

General Steps of Creating a Dynamic Block Definition 

In order to get a Dynamic Block Definition, improve block editing efficiency and avoid repeating 

modifications, we can create Dynamic Block by the following steps. 

Step1: Planning: 

Before creating Dynamic Block, it is essential to plan Dynamic Block, plan the functions, appearance, the 

method of drawing and required Parameter(s) and Action(s) which are needed to achieve prospective 

functions. 

Step2: Draw geometric figure: 

The included basic pixel during Dynamic drawing, of course you can draw these pixel in Block Editor. 

Step3: Add Parameter and Action: 

This is the most pivotal step when creating Dynamic Block. When editing the Parameter and Action, you not 

only consider the achievement of Parameter and Action, but also consider the readability of Dynamic Block 

and the convenience of Modification, let the action point of the Parameter attach on the corresponding pixel 

as far as possible, and put the Action near to its relevant parameter, if there are more Parameters and 

Actions, they still need to be renamed for understanding, editing and Modification. 

Step4: Test Dynamic Block 

Save and Exit Block Editor, start the Dynamic Block test to check if it reaches to the prospective effect. 
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Dynamic Block Creation (Visibility)                                                                                                

Using the Visibility Parameter function, you can control the display and hide a certain view in Dynamic Block. 

1. Prepare view:  

Draw three cars as below and define all of them as block. 

 

 

 

 

 

2. Add Parameter of Visibility:  

Enter into Block Editor by Double-clicking the block or right- click the menu, click the button Visibility of 

Parameter in the Parameter panel, appoint the position of the Parameter according to the system prompt, 

as shown below. 

 

 

 

 

 

 

3. Edit Visibility States:  

Click the visibility states button, then the Visibility States dialog 

box will be displayed. In the dialog box, you can rename, create 

new and remove Visibility States. In order to control the visibility 

of the three cars view in this example, we click new option for 

the three Visibility States as shown in the picture. 
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 Click the following button as shown in the picture and choose roadster in the 

pull down menu. 

Click the òInvisibilityó button in the Visibility tool panel, select truck and car 

drawings, then make them invisible in the òroadsteró state, as shown in the 

following picture, after selecting, press enter to confirm. For the state of òCaró and òTruckó, set them in the 

same way. 

 

 

 

 

 

 

4. Move and Adjust: 

 After finishing the editing of the Visibility States, move the three cars view to make them overlap each other 

as shown in the picture bellow. 
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5. Test Dynamic Block:  

Insert the Dynamic Block into a drawing, select Dynamic Block and click the grip of Visibility Parameter, 

choose one item in the pull-down list, Dynamic Block will change the display state automatically, as shown in 

the following picture. 

 

 

 

 

 

 

 

Dynamic Block Creation (Alignment)                                                                                                

Alignment Parameter can give dynamic blocks the function of alignment automatically, which can save the 

step of rotating the blocks. 

1. Add an Alignment Parameter for a Roughness Symbol:  

Draw a roughness symbol in the Block Editor. Select the icon of the alignment parameter. Specify the 

location and the aligned orientation of the parameter following what the computer asked as shown in the 

picture, the dotted line is the align orientation. 

 

 

 

 

2. Test Dynamic Block:  

Insert the roughness dynamic blocks, move the align grips, the symbol will align with the interface of the 

dimensions, as shown in the picture below. 
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Dynamic Block Creation (Flip)                                                                                                

When you use the "roughness symbol block" to label the spare parts, the symbol is sometimes already in the 

right position, however, the characters' direction is not right. We need to add the "character flip" function to 

receive the correct label. 

1. Add Flip Parameter:  

Click the "flip" parameter button; add the flip parameter according to 

prompt, as shown in the picture. 

 

 

2. Add Flip Action:  

Click the flip action button on the action panel, match parameter and 

object for the action. Herein, we choose "roughness" as the object, and 

position the action button, as shown in below picture. 

Use the same method to add a pair of flip parameter and action of the vertical direction, as shown: 
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3. Test Dynamic Block:  

As you can see, after add flip parameter, if only click flip grip, you can turn the characters to the correct 

direction. 

 

 

 

 

 

Dynamic Block Creation (Linear Stretch)                                                                                                

For example, during mechanical design, we often need change the position as well as the dimension of the 

keyway. In this section, we will add Linear stretch function for the keyway on the step shaft. 

1. Add Linear Parameter:  

Add linear parameter to object as shown below: 

 

2. Add Stretch Action:  

Click stretch action button on action panel, choose parameter according to prompt and define right grip as 

key parameter point, as shown in below picture. 
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Blacken object is the operational object of the action, broken line frame is the stretch frame, objects intersect 

with stretch frame will be stretched, objects which be selected by stretch frame will move. 

3. Test Dynamic Block:  

Exit from block editor, drag stretch grip to stretch the keyway, as shown in below picture. 

 

 

 

 

Dynamic Block Creation (Parameter Value Set)                                                                                                

For mechanical design, we often need stretch the keyway to a certain length. Now, let us see how to realize 

the accurate stretch. 

1. Pick Linear Parameter:  

In block editor, pick the linear parameter, then click entry frame which is in the right side of "distance type" 

on Properties panel, there comes one drop-down menu. 

 

 

 

 

Therein, none is default option, means can stretch optionally. By other two options, you can define 

maximum and minimum number respectively. 

"Increment" means stretch increasingly, Value set appears like below after select 

increment. 
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If you choose "list", Value set appears like below picture, dynamic block can only 

be stretched accord with the number in the list. 

 

2. Click Text Frame:  

Which is in the right side of "distance value list". Click this button, it comes "Add distance" dialog box. Add 

three numbers ò1ó.ò1.5ó.ò2ó in the dialogue box, as shown in below picture 

 

 

 

 

 

3. Test Dynamic Block:  

Exit from block editor and stretch the right grip, you will realize several gray lines appear in the right side of 

keyway, and keyway can only be stretch to the gray line position, as shown in below picture. Obviously, by 

value list, you can define certain numbers of the stretch, to realize accurate stretch. 

 

 

 

 

Dynamic Block Creation (Symmetrical Stretch)                                                                                                

There is an easy way to realize the two-way stretch which is adding two stretch actions. Though it can realize 

two-way stretch, the action of stretch is independent. The parameter needs some additional setup to realize 

the two-way symmetrical stretch. 
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1. Add Stretch Actions: 

Add two stretch actions for parameter, and select the two grips of the two parameters as the relevant point 

of each action. 

2. Modify Base Location:  

In the misc, modify the base location from "Start Point" to "Mid Point", like the shown picture below. Save 

and quit the block editor. 

 

 

 

3. Test Dynamic Block:  

For the convenience of watching the effect, we draw a vertical center line at the middle of the keyway, and 

then stretch the grip to the left side of the keyway or the right side. Like the shown picture below. As the 

grips moving, two-way symmetrical stretch realized. 

 

 

 

 

Dynamic Block Creation (Distance Multiplier)                                                                                                

Take step shaft as an example, if we stretch the left part of the step shaft and the keyway still is at the center 

point of smaller diameter shaft after stretching. As the following picture shows: 
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Then, we use òDistance Multiplieró property of action to achieve the aim. 

1. Add Linear Parameter and Stretch Action for Step Shaft:  

Hide right grip of parameter point, action stretch box is as the following picture, the bolded object is action 

operation object. 

 

 

 

2. Add Move Action for keyway:  

Select left grip of linear parameter when moving, stretching related parameter points. Move objects of action 

select the whole keyway, as the following picture. 

 

 

 

3. Modify Distance Multiplier of Action:  

Select Move Action and modify the default value from 1 to 0.5 in the property of distance multiplier, save an 

exit block editor. 
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4. Test Dynamic Block:  

Stretch leftwards grip and with grip moving leftwards, the smaller diameter shaft will appear stretch effect, 

keyway also will move leftwards accordingly, meanwhile, keyway is in the center of smaller diameter shaft of 

step shaft all the time, as the following picture 

 

 

 

 

 

 

Although Stretch and Move have a common parameter, but when Distance Multiplier of Move is modified as 

0.5, the displacement of Move can only stretch 0.5 times of displacement. 

 

Dynamic Block Creation (Chain Action)                                                                                                

If you want to realize symmetric stretch keeping keyway center no change and the length of smaller 

diameter shaft changes with stretch at same time, how will realize that? 

1. Add Stretch for Step Shaft:  

Add stretch parameter and action for step shaft as the following picture shows. Therein to the bolded 

objects indicates the operation object of action. 
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Because the follow-up operation will not stretch step shaft by grips of this linear parameter, the gripõs 

number of linear parameter can be modified as ò0ó. 

2. Add Linear Parameter for Keyways: 

Set the base point position of line parameter as òCenteró in order to realize symmetric stretch function. 

 

 

 

3. Add Stretch Rightwards Action for Keyway 

 

 

 

 

4. Realize Chain Action:  

Select òDistanceó linear parameter and modify the chain action of prosperity from òNOó to òYesó as the 

following picture shows. 

 

 

 

 

Add Stretch Leftwards action for keyway as the following picture shows. Special Notes: Do elect òDistanceó to 

linear parameter to stretch leftwards operation objects set. This is a necessary procedure of chain operation. 
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5. Test Dynamic Block:  

After dragging left grip not only the keyway will stretch bi-directionally and symmetrically but also smaller 

diameter shaft of step shaft will stretch automatically. This is chain action. 

 

 

 

 

The realization of chain action has two important procedures: First, modify the property value of the 

parameter that need to happen linkage and modify the property of òchain actionó from òNOó to òYESó. 

Second, select the parameter of objects that selected to linkage action to set. 

 

Knowing more about dynamic block editor                                                                                                

You use the Block Editor to define and modify the objects and behavior in a block definition. In the Block 

Editor, you add parameters and actions, which define custom properties and dynamic behavior. 
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You can access the Block Editor by typing BEDIT command or double-click the block without attribute. You 

will see The Block Editor ribbon interface as below, the black arrows mark stand for parameters, while yellow 

lighting symbol for action. If users are working under classic interface, it will pop-up toolbars. 

Dynamic Block Editor Tool Panels:  

You can uses the tools at Panels to define, edit and modify dynamic block definitions , makes it very 

convenient and fast. 

Manage: Save or Save as the default block; Create or edit another block. 

Tool: Define, edit or update the block attribute. 

Parameter: You can add parameters for Dynamic Blocks on this panel. 

Action: You can add actions for Dynamic Blocks on this panel. 

Parameter Sets: You can add the parameter set on this panel. 

Visibility: This panel is specially used for Visibility editing. 

Close: It is used to exit the Block Editor. Before exiting, some commands like save or open etc. might not 

work. 

 

Knowing more about parameters in dynamic block editor                                                                                                

Parameters have an appearance similar to dimensions. Parameters also specify positions, distances, and 

angles for geometry in block reference. When you add a parameter to a dynamic block definition, the 

parameter defines one or more custom properties for the block. 
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A dynamic block definition must contain at least one parameter. When a parameter is added to a dynamic 

block definition, grips associated with key points of the parameter are automatically added. You must then 

add an action to the block definition and associate the action with a parameter. 

 

 

 

 

 

 

 

Point Parameter: Defines an X and Y location in the drawing. A point parameter can be associated with a 

move or stretch action. 

Linear Parameter: Shows the distance between two anchor points. Constrains grip movement along a preset 

angle. A linear parameter can be associated with a move, stretch, scale or array action. 

Polar Parameter: Shows the distance between two anchor points and displays an angle value. You can use 

both grips and the Properties palette to change both the distance value and the angle. A polar parameter 

can be associated with a move, scale, stretch, polar stretch, or array action. 

XY Parameter:  Shows the X and Y distances from the base point of the parameter. It can be associated with 

a move, scale, stretch, or array action. 

Rotation Parameter:  Defines an angle. The rotation angle can be in any value, or be defined in a range or a 

specified value. 

Alignment Parameter: Defines an X and Y location and an angle. An alignment parameter always applies to 

the entire block and needs no action associated with it. An alignment parameter allows the block reference 

to automatically rotate around a point to align with another object in the drawing. An alignment parameter 

affects the rotation property of the block.  

Flip Parameter:  A flip parameter flips objects. You can associate a flip parameter with a flip action. 

Visibility Parameter: Controls the visibility of objects in the block. A visibility parameter always applies to the 

entire block and needs no action associated with it. In a drawing, you click the grip to display a list of visibility 

states available for the block reference. 
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Lookup Parameter: Defines a custom property that you can specify or set to evaluate a value from a list or 

table you define. It can be associated with a single lookup grip. In the block reference, you click the grip to 

display a list of available values. You can associate a lookup parameter with a lookup action. 

Base Point Parameter: Defines a base point for the dynamic block reference relative to the geometry in the 

block. Cannot be associated with any actions, but can belong to an action's selection set. 

Point Parameter: Defines an X and Y location in the drawing. A point parameter can be associated with a 

move or stretch action. 

Linear Parameter: Shows the distance between two anchor points. Constrains grip movement along a preset 

angle. A linear parameter can be associated with a move, stretch, scale or array action. 

Polar Parameter: Shows the distance between two anchor points and displays an angle value. You can use 

both grips and the Properties palette to change both the distance value and the angle. A polar parameter 

can be associated with a move, scale, stretch, polar stretch, or array action. 

XY Parameter: Shows the X and Y distances from the base point of the parameter. It can be associated with 

a move, scale, stretch, or array action. 

Rotation Parameter: Defines an angle. The rotation angle can be in any value, or be defined in a range or a 

specified value. 

Alignment Parameter: Defines an X and Y location and an angle. An alignment parameter always applies to 

the entire block and needs no action associated with it. An alignment parameter allows the block reference 

to automatically rotate around a point to align with another object in the drawing. An alignment parameter 

affects the rotation property of the block.  

Flip Parameter: A flip parameter flips objects. You can associate a flip parameter with a flip action. 

Visibility Parameter: Controls the visibility of objects in the block. A visibility parameter always applies to the 

entire block and needs no action associated with it. In a drawing, you click the grip to display a list of visibility 

states available for the block reference. 

Lookup Parameter: Defines a custom property that you can specify or set to evaluate a value from a list or 

table you define. It can be associated with a single lookup grip. In the block reference, you click the grip to 

display a list of available values. You can associate a lookup parameter with a lookup action. 

Base Point Parameter: Defines a base point for the dynamic block reference relative to the geometry in the 

block. Cannot be associated with any actions, but can belong to an action's selection set. 
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Knowing more about actions in dynamic block editor                                                                                                

Actions define how the geometry of a dynamic block reference will move or change when the custom 

properties of the block reference are manipulated in a drawing. 

 

 

 

 

 

 

 

Move: Move action causes objects to move a specified distance and angle such as a point, a linear, a polar, an 

XY parameter, etc, moves all objects in a selection set in a/any direction. 

Scale: Scale action such as a linear, a polar, an XY parameter, and so on, scales the selected objects in the 

direction of the parameter. Users can manipulate the grips in different way by changing the properties and 

values in the Properties palette. 

Stretch: Stretch action causes objects to move and stretch a specified distance in a specified location. A stretch 

action associated with a point, a linear, a polar, an XY parameter, etc.  

Polar Stretch: Polar stretch action rotates, moves, and stretches objects a specified angle and distance when the 

key point on the associated polar parameter is changed through a grip or the Properties palette. A polar stretch 

action can only be applied to a polar parameter. 

Rotate: Rotate action is always associated with a rotate parameter. Selected objects can be rotated freely, or the 

way the grips are manipulated is different in the Properties palette.  

Flip: Flip action is always associated with a flip parameter.  

Array: Array action is associated with a linear, a polar, an XY parameter, etc, copies and arrays selected objects in 

different way.  

Lookup: Lookup action can only be associated with a lookup parameter.  

 

 



 

34 

 

How to reference objects to file/URL in GstarCAD? 

In GstarCAD is possible to link an object to another file. So if you needed to see the components specifications 

or 3D model of a certain component from a drawing, you can add hyperlinks to an object. The hyperlinks can 

be pointed directly to a manufacturer website, to a word document that contains the installation procedure, or 

to excel file that contains product specifications as samples. 

 

Adding and Using Hyperlink 

Adding a hyperlink is very easy. Activate hyperlink from menu: Insert> Hyperlink, or from ribbon: Insert> Data 

panel. 

 

 

 

 

GstarCAD will ask you to select object, then you will see this dialog box: 

 

 

 

 

 

 

 

 

In this example you can add link to specification document in your local computer, or you might want to point it 

to a file on your server. Or a page on website. Not only website link and local files, you can link to layout or 

saved view in your model. You can also link to email address. Maybe you want to link a certain item to vendor 

contact person for maintenance or something. This can be useful for building maintenance purpose. 

 

 

 

 

 

How to draw an arc with a specific arc length? 

There are some methods that seem to allow you define length. For example start, center, length. But this is 

defining the chord length, not the arch length. Calculating the angle using simple mathematic calculation, 
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comparing the arch radius and arch length. After you get the angle value, then you can draw it. But it is not 

easy! 

 

 

 

 

 

 

 

 

 

 

A better solution is drawing the arch, then modify it using LENGTHEN command. Lengthen command allows 

you to define the object total length, including an arch. Select the total lengthoption, then type the distance you 

want. 

 

 

 

  

 

 

 

Now if you try to inquiry or see the arc properties, you will see the arch has the exact length I wanted. 
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How to enable object snap to hatch? 

There are several users asking, why they canõt snap to hatch object, the answer is simple, because they did not 

enable a drafting option to snap to hatch object.  

 

 

 

 

 

 

To activate it, simply issue OPTION command. In option dialog box, drafting tab, in object snap options, turn 

off ignore hatch objects.You can also set this option by changing OSOPTIONS system variable. 

 

 

 

 

 

 

 

 

 

 

How to make a multicolored line entity or with embedded text in GstarCAD? 

Although it may sound impossible, you can draw multicolored lines/polylines in GstarCAD. 

MLINE functionality can be used for this. Use the MLSTYLE command to define a new multiline style and define 

(element properties) two line elements, both with the offset equal to 0. Set different colors to them (e.g. green 

and red). Use different linetypes, e.g. DASHED and DASHED2 (you may need to Load them first) - for real-life 

applications you will probably need to define your own linetypes. Save the new Mline style.  

 

 

 

 

http://www.cadforum.cz/cadforum_en/command.asp?cmd=MLSTYLE
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Now use the MLINE command to draw a polyline using this new mlstyle - it has alternating green/red colors! 

You can use the same approach to define even three or more colors. 

 

 

As GstarCAD allows defining complex linetypes containing text, you can even make linetypes (mlines) with 

embedded text in a different color than the line (e.g. line in a BYLAYER color and text always in blue). For this 

you need to define one complex linetype containing text and almost no lines (e.g. only dots) plus an 

appropriate dashed linetype with spaces for the text. 

 

 

  

  

  

 

 

 

 

 

 

 

 

http://www.cadforum.cz/cadforum_en/command.asp?cmd=MLINE
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How can I draw a tangent line off an arc within a polyline? 

You may have noticed that when you go to the ARC mode within the PLINE command, the first and consecutive 

arcs are tangent to the previous segment. To create a tangent line off the last segment, first press L for Line 

mode, then press a second L for Length.  Pick or enter a distance and the segment drawn will be tangent off the 

last arc. Itõs the 2nd L that does the trick. 

 

 

 

 

 

 

 

 

How can I create a circular wipeout? 

Many CAD users want to create a circular wipeout, as you may or may not know, you cannot create a wipeout 

using a circle, only a closed pline without any arcs. Instead, use the POLYGON command. 

 

1. Enter the command POLYGON, 

2. When prompted to enter the number of sides, enter a value of 36 which will create a closed pline that looks 

just like a circle. You can assign the value of 36 sides for the pline because it looks just like a circle without 

having too many vertices that make the closed pline too òbusyò 
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3. Then use of the WIPEOUT command like you normally would, and choose Polyline option, then select the 

pline created and done! Also you can change the wipeout properties via properties window. 

 

 

 

 

 

How to create 2D isometric drawing? 

If you work in plant industry, then you might need to draw isometric drawings. If you use GstarCAD, you may 

wish you can do it easily. Itõs not a 3D drawing, but 2D drawing by simply change your drawing orientation. You 

can do it by using snap, then change its style to isometric. 

 

 

Command: SNAP 

Specify snap spacing or [ON/OFF/Aspect/Style/Type] <10.0000>: S 

Enter snap grid style [Standard/Isometric] <S>: I 

Specify vertical spacing <10.0000>: 10 
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Also you can change your plane by typing ISOPLANE [enter] then select left, top, right.Alternatively, you can use 

the SNAPSTYL command, changing the variable value to 1. You can change your plane by typing ISOPLANE, 

but it can be done faster by pressing òF5Ż key. To came back to the default, use the SNAPSTYL command again 

and change the variable value to 0. 

 

 

 

 

 

 

 

A sample of GstarCAD's geometry calculator 

People often don't know about GstarCAD's built in geometry calculator. While it lacks in interface appeal it more 

than makes up for it in capability. Take the ability to snap to a point between to endpoints. Consider this 

example where a circle is placed halfway between the endpoints of two lines. 

Command: CIRCLE 

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: 'CAL 

>> Expression: MEE 

>> Select one endpoint for MEE: 

>> Select another endpoint for MEE: 

The key is when prompted to specify any point, enter 'CAL and type in the expression.  In the case of MEE it 

knows you want endpoints and you don't have to use an object snap when picking.  Also bear in mind that MEE 

is only one of dozens of expressions available in GstarCAD. 
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How do I change Mtext to lower case or upper case? 

You might make a mistake and want to change the text caseê either to lower case or upper case. Do you need 

to re-type it? No way! It is easy to do. 

1. Select the word you want to change for. 

2. Right click in the word, select the CHANGE CASE option> Lower case or Upper case from the context menu. 

3.  

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Alternatively, press [Ctrl] + [Shift] + U to set the text to upper Case OR press [Ctrl] + [Shift] + L to set the text 

to lower case. 

 

How do I move, rotate, and scale an object at once? 

ALIGN command is often overlooked by many CAD users. Instead of using move, rotate, and scale commands 

separately, you can do it at once using this tool. 

 

With ALIGN you can move, rotate and scale an object while aligning it with existing geometry or selected points. 

You can also scale and align images. 

  

Just draw a line to the òknown lengthó, select the two corresponding points on the image and use the scale 

option to rotate, scale and place the image perfectly. 

 

Modify  
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4 SHIFT key combination you might not know 

It is great to know that GstarCAD offers keys combination that helps modify basic objects quickly. Many people 

donõt realize that using shift combination can increase their productivity. Here is a little list that might interest 

you: 
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1. Hold [shift] + right click. 

This shortcut key combination will display context menu for snap overrides really quickly. Try to hold [shift] then 

right click. Release, then press [E] to activate end point snap. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Hold [shift] for temporary ortho mode 

Holding this key while you draw, will activate temporary ortho mode. Exactly like when you activate ortho mode 

by pressing [F8]. But this is just temporary. 

 

 

 

 

 

 

3. Holding [shift] while chamfering and filleting 

You know what will happen if we hold this shortcut key when we use chamfer or fillet? It will override the 

distance or radius value, and will use 0 (zero) value! Pretty nice. 

 

4. Holding [shift] while using trim/extend 

When we use trim, sometimes we want to extend other objects to the same reference. You donõt have to finish 

your trim session, and activate extend to do it. Just hold [shift], then trim will be inverted to extend command. 

This work on the other way when extend command is active, it becomes trim! 
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How to modify objects with non-uniform scale? 

Just using a simple tool. In the drawing below, if you notice blue cloud area, you can see that the columns or 

pillars do not fit in width with the long narrow balcony. By the way the columns are block objects.  

 

 

 

 

 

 

 

 

 

 

 

 

Do not worry; there is an effective way to solve this issue. You can use non-uniform scale option for the column. 

It only scales it on X axis, but ignore the scaling on Y axis. How to do this? 

 

1. Type INSERT command and the INSERT dialog box will pop up. 

2. Search the COLUMN block. 

3. Under Scale> uncheck the Uniform Scale option. 

4. Left the X value to 1, and change the Y value a bit, letõs put value 2 as sample. 

5. Click OK button. Just you need to place it correctly and make several copies, done!  
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How to annotate isometric drawings? 

Have you tried to annotate your isometric drawings? How about dimensions and text, is it appear properly? No 

itõs not. The drawing looks isometric, but not the annotations. So how can you create isometric annotations? 

 

Isometric Text 

First, create two text styles within the Text Style dialog box. Use oblique angle 30 deg for one style and -30 deg 

for the other. 

 

 

Now try to create text (single or multi line) with different styles and angle combination, then change the rotation 

to 30 deg or -30 deg. It depends on where you want to put it. See next image as reference. 

 

 

 

 

 

 

 

 

 

 

 

Dimension 
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Isometric Dimension 

What about dimensions? You also have to create two styles within the Dimension Style Manager dialog box. 

One of the style use 30 deg text style, and the other one use -30deg. 

 

Now place aligned dimension. Notice that the extension lines of the dimension 

placed are not perpendicular as the blue line. Now we have to do a little 

modification. 

Activate DIMEDIT [enter], choose OBLIQUE, then give 30 or -30 as oblique angle. 

Once again, depends where your dimension is. 

 

Command:  DIMEDIT 

Enter type of dimension editing [Home/New/Rotate/Oblique] <Home>: O  

Select objects: 1 found 

Select objects: 

Enter obliquing angle (press ENTER for none): -30 

See this image as reference. 
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How to set a dimension style to content always blank? 

If users do not want to show dimensions value for a particular reason, they can make the dimension contents 

permanently blank by following the steps below: 

1. Create a new dimension style in the dimension style dialog box. 

2. Go directly to primary units tab, on prefix blank space, type in:  \H 

3. If you are using a precision unit like: 0,0, you must type \H on suffix as well. 

4. Click OK button and set current your new dimension style. Done, just try it! 
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Navigate between model and paper space with hyperlinks 

Below is a step-by-step process that helps you quickly navigate between Model space orientations and multiple 

Layout tabs using Saved Views and Hyperlinks (this tip is lengthy, but so worth the effort). 

 

1. While in a Layout tab, use the VIEW command to save a view name (usually, I would name the view based on 

whatever the sheet number would be, like òA101ó) 

 

 

 

 

 

 

 

 

 

View & Settings 
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2. Then, draw a closed pline around the perimeter of a Viewport (either on Layer òdefpointsó or a unique layer 

set to òno plotó), and then use the CHSPACE command to send the pline into Model space through that 

Viewport. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. With your cursor still within Model space via inside the Viewport, save a new view name to something 

reflecting what is going on within the viewport and including the sheet number (eg. òPlan 1 ð A101ó), and then 

bring your cursor back into the Layout environment (ie. PSPACE command) 

 

 

4. Enter the command HYPERLINK. 

5. When prompted to òSelect Objectsó, select the Viewport boundary that you just saved a view in. 
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6. When the òInsert Hyperlinkó dialog box appears, click on the òView of this Drawingó button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Expand the Model tree by clicking on the ò+ó symbol, select the view name you just created, and then click 

the OK button 

 

 

 

 

 

 

 

 

 

 

 

Now, hold down your Ctrl key, and click once on the Viewport boundary with your left mouse button. GstarCAD 

will then switch to Model space and zoom into the area of the saved Model space view that you created earlier 

and you will also see the closed pline that you sent through the Viewport. 
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Why specific objects in my drawing are shown as boxes? 

Have you ever found that when you open a drawing, you see your texts are missing? You only see them as 

boxes like below. 

 

 

 

 

 

 

 

 

 

This is actually a setting to simplify the drawing appearance. By simplifying the text appearance, you can work 

with drawing faster. Check the trick to turn on the missing text in your drawing. 

 

QTEXT 

The system variable that responsible for this appearance is QTEXTMODE. This system variable is stored in 

drawing, so itõs drawing specific. Not for all drawings. You can turn it on/off by typing QTEXTMODE. Value 1 

means it is active and 0 is inactive (default). So use it only when you donõt work with text. 
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GstarCAD match properties settings 

Many users already know that we can match object properties using MATCHPROP (or MA for short key in). This 

tool is very handy for you who want to change an objectõs properties to copy other objects. But many of us 

donõt realize that there are some settings that we can use in this tool. It allows us to use this tool to match only a 

specific property. Letõs say you want to copy an object line style. But you donõt want to copy its color, layer, and 

any other properties.  

 

Letõs try to activate this tool. Type MA then hit [enter]. 

You can also use activate this tool from GstarCAD ribbon> home tab> clipboard panel> match properties. 

 

 

After you activate the tool, pay attention that there is an option to choose settings in the command line. Type S 

then hit [enter]. 

 

 

 

 

 

 

 

 

 

 

You will see property settings dialog box. Uncheck anything that you donõt want to change. Click OK. Now you 

can copy selective properties to your GstarCAD objects! 

 

Tools 
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Move objects together or edit them individually by group tool 

Do you ever need to move or edit objects together but still have the need to edit those same objects 

individually? GstarCAD can do that with GROUPS. 

Groups are different from blocks. With blocks, you can manipulate the block as a whole, and thatõs it. With 

Groups, you can edit the object but it wonõt change other instances of that group. And you canõt share groups 

from file to file. Making groups is rather easy.  

1. Start the GROUP command. 

2. Fill out the GROUP NAME field (to name your group) and enter a description. If you donõt enter a 

description you can always fill this out later.  

3. Then hit the NEW button. Select the items you want to group and hit enter. Youõre done. You now 

have a group. 

 

 

 

 

 

So, what can you do with a group? You can GRIP edit the items individually, move/copy/scale the group as a 

whole. Double clicking the text in a group wonõt invoke the text editor. You have to start the text editor 

command then select your text to change it. 

 

 

 

 

Now what else can I do with a group? Open the GROUP Manager (type in GROUP).You will get a list of every 

group in the file. Pick one, and then hit the HIGHLIGHT button. That group will be highlighted in your file 

making it easier to find. A ZOOM TO feature would be nice. You can remove the selectable feature from a 

group, if you want to (do this to be able to delete a specific item). That will remove your ability to 

copy/rotate/scale/move the group as a whole. You can put it back later if you want to. 

 

 

http://cadablog.blogspot.com/2008/06/groups-you-gotta-keep-em-seperated.html
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With the Group Manager, you can add or remove items from a group. Click the proper button and then select 

the items to add/remove to/from the group. You can reorder the order in which the groups appear in the 

manager; you can explode a group, rename it or edit the description. 

 

How to copy relevant features from another drawing? 

Users will have the ability to copy relevant drawing features like dimension and text styles, blocks, layers, 

linetypes and xrefs from Drawing A and add it to Drawing B using DESIGNCENTER tool in GstarCAD. 

1. To open DesignCenter, you can either use Ctrl +2, or go to the View tab>Palettes panel>DesignCenter.           

2. Navigate to the drawing containing the layout tab you would like to add to the current drawing.                    

3. Expand the drawing node by clicking the plus sign (+) to display the available content from that drawing 

which can be brought into the current drawing.                                                                                                 

4. For example, click on the Linetype to display the linetypes contained in that drawing.                                                                   

5. Select the linetype you want and drag it into the drawing area! 

 

 

 

 

 

 

 

 

 

 












































































